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Overview 

Business agility through synchronized business and IT cycles 

The ability to deal with change in operational systems is directly related to the decisions that they are 
able to make. Every transaction, order, customer interaction or process is dependent on decisions, which 
are in turn dependent on particular internal or external requirements and situational contexts. Every 
change therefore affects decisions, many of which are handled automatically within business systems. 

Business agility depends on responsive, intelligent decision automation. With WebSphere Operational 
Decision Management, you manage decisions separately from business applications, with more flexibility 
and responsiveness to the changing needs your business. 

When decision management is separate from application code, business experts can define and manage 
the business logic, reducing the amount of time and effort required to update that business logic in 
production systems, and increasing the ability of an organization to respond to changes in the business 
environment. 

WebSphere Operational Decision Management includes two main components, on both distributed and 
z/OS platforms: 

 Decision Server for managing decisions separately from applications. 

New IT architectures like Service Oriented Architecture (SOA) allow loose coupling of the 
applications or processes. Business logic can be encapsulated as decision services, which the 
applications and processes can call. Decision services enable the operation of Business Process 
Management (BPM) solutions with decision management. 

 Decision Center for putting decision management in the hands of those who drive the business. 

Business users can manage decisions directly with limited dependence on the IT department. 
The degree of dependence can range from limited review by business users of the business logic 
implemented by developers to complete control over the specification, creation, testing, and 
deployment of the business logic by business users. 

From business policy to business rules 

Business policies are statements that are used to make decisions such as pricing for insurance or loan 
underwriting, eligibility approvals for social or health services, or product recommendations for online 
purchases. Business policies are typically found inside application code, in the form of if-then statements, 
although they may also be stored elsewhere for documentation purposes, such as in procedural manuals 
and other documents. 

A business policy can be expressed as several business rules. Here is an example of the kind of 
business policy that might be familiar: 

Customers who spend a lot of money in a single transaction need an upgrade. 
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The process of capturing rules consists of formalizing the vocabulary required to express the policy as a 
conceptual object model and representing the logic of the business policy as if-then statements. 

After the vocabulary has been created, the above business policy can be implemented with the following 
business rule: 

if  

    the customer's category is Gold  

    and the value of the customer’s shopping cart is more than $1500  

then  

    change the customer's category to Platinum 

When a business policy also has an IT policy or security policy embedded in it, you can combine 
Business Rule Management with additional capabilities to handle the business policy aspects. For 
example, customers who spend a lot of money should be routed to a preferential service or customers 
who spend a lot of money require additional security on their transactions. 

In the form of business rules, the business logic can be packaged and called from the application code 
as a business rule application. Therefore, changes to the business policy do not require changes to the 
application or process code. 

From event pattern detection to event rules 

An event is an electronic signal indicating that a change in the state of the business has occurred. 
Orchestrating business events so that the right applications run at the right time for the right purpose is a 
challenge that can be particularly difficult with the large variety of business systems currently running in 
the enterprise. A wide range of technologies is also employed, ranging from batch processing 
applications to client/server, and to browser-based intranet and internet applications. Orchestrating the 
processing of the events that occur in these systems, as well as the events that occur manually, might 
potentially mean major system redesign and many months of modifications, tests, and deployment. 

A rapid business systems orchestration requires an alternative approach to complex and expensive 
redesign and redeployment of existing systems is required. The solution is to implement a Business 
Event Processing layer that sits across existing systems, takes advantage of functions already 
developed in those systems, and manages the complex interactions (business events) that can occur 
between those systems. This layer of architecture is known as Business Event Processing. The Business 
Event Processing layer communicates significant events in one business system to other systems that 
require the information to respond to the critical event. 

In large organizations, tens of millions of events occur everyday, but not all events or event occurrences 
are of equal importance. Providing insight requires the ability to determine when a pattern of seemingly 
unrelated events from one or more sources has occurred and then to coordinate the execution of the 
responses to that pattern of events. 

Business Event Processing is the ability to sense when a business event or event pattern has occurred 
(or not occurred), indicating an actionable business situation, and to coordinate the right response or 
action, at the right time. 
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Event rules help detect, and respond to, event patterns among like or related events, missing events and 
aggregate events. Event rules also relate the pattern detection to a context and apply a dimension of 
time to the pattern. So, for example, the following logic can be created: 

if events A and B occur and event C does not occur in <time frame>, then do 

actions X, Y and Z after time frame 

For example, on a retail web site, if a customer adds a book to his or her shopping basket (event A) and 
views the delivery information page (event B) but does not complete the purchase at the online checkout 
(event C) within one week, then send an E-mail to this customer (action X). After one more day has 
passed, update the customer favorites database with the book details (action Y), and send a message to 
the Sales department to tell them this customer did not complete the purchase (action Z). 

By using predefined logic that describes how business systems are to interact, the event runtime can 
notify those systems in real time so that they take the appropriate action. 

Synchronized business and IT cycles 

WebSphere Operational Decision Management provides an environment for designing, developing, and 
deploying business rule applications and event applications. The IT cycle consists of developing and 
maintaining this infrastructure. After the infrastructure is set up, distributed business teams can start 
collaborating through a Web-based environment to create and maintain business rules and events. 

The life cycles of decision management and application development can evolve in parallel. Decisions 
can evolve as required by the business context, without putting an extra load on the development of the 
application. Each time the application evolves, the decision management environment synchronizes with 
the application. 

With this separation, decisions and application architecture can be managed asynchronously. For 
example, application developers can develop a new application version in response to changing 
application infrastructure and additional core business requirements. At the same time, policy managers 
can work on new decisions delivered in response to an evolving market, changing regulatory 
environment, or new patterns of events. 
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In addition to working on different time lines, developers and business users also expect to work with 
different tools, reflecting their different skill sets and views of the application. 

For example, developers are accustomed to the Java world. They use source-code management 
systems to work simultaneously on separate copies of a project without interfering with each other. 

Business users, on the other hand, do not concern themselves with the details of application 
development, but are interested in testing and managing decisions. Therefore, they need tools that can 
help them author, organize, and search for rules in the context of the overall policy. 

With developers and business users working in their own environments at their own pace, the work of 
these two groups must be synchronized and merged. 

Finally, both developers and business users require access to a rule execution environment to deploy 
rules to enable testing, validation, and rollout to production of new and changed business logic. 
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Introduction 

This section describes the scenario you will work through during this tutorial. 

The Retail Banking Business Application 

This tutorial is based on a sample retail banking application. The tutorial objective is to develop the 
application to support simple business requirements. Initially, we will be sending alerts when card 
transactions occur. We will then expand the application to correlate activity such as address changes 
and multiple transactions in order to be more responsive to opportunities and threats. The goal is to 
introduce the participant to the basic concepts of event processing using Operational Decision 
Management. 

Introducing the Tutorial Environment 

This section introduces the components you will be using in the tutorial and the steps you will be taking. 

The WebSphere Decision Server CEP modules 

WebSphere Decision Server includes a set of modules that support Complex Event Processing (CEP) 
management across a variety of different environments, but also work together to provide a 
comprehensive system. The modules included with WebSphere Decision Server are: 

 Event Designer – The development tooling used by developers and architects to develop and 
integrate event processing with other applications. 

 Event Execution Runtime – The event engine that provides the capability to deploy and execute the 
event rules. 

Business Users would frequently leverage other modules not included with WebSphere Decision Server 
including: 

 Decision Center – The Business rule management system providing authoring and governance of 
rules aimed at business users. 

 Business Space – Provides a framework of thin-client, end-user tooling for both design-time and run-
time purposes. 

 

WebSphere Operational Decision Management comprises a set of modules that operate in different 
environments, but also work together to provide a comprehensive decision management platform. 
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Two categories of users are involved in developing and maintaining a decision management solution: 

IT users 
 
Architects, developers, and administrators develop and maintain the event application. 
Developers work with Event Designer in Eclipse for design and event project development. Using 
capabilities in Business Space, they can also test event logic against real or fictitious scenarios to 
support and troubleshoot problems found in Decision Center. 
 

Business users 
 

 Business users work with Decision Center to write and maintain event rules, both during application 
development and after the application is deployed to production. 

 Business users can perform end-user testing and simulation in Business Space. Business analysts 
can simulate events, run updated rules against recorded historical data, and analyze the outcomes. 

Overview of Tutorial tasks  
 
The tutorial also offers an introduction to both Decision Server and Decision Center where you take 
the role of a business user first to manage the event rules developed in Decision Server from a Web-
based environment and then the role of an IT user to discover how the business rule application was 
built. 
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The tutorial is divided into three parts using the modules provided with WebSphere Decision Server as 
shown below. 

Students are advised to progress through these tasks in order.  Each task is divided up into steps that 
incrementally build the solution to the scenario described in the next section.  Solutions are available at 
certain steps in the tutorial allowing the student to catch up quickly if mistakes are made in earlier tasks. 
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Pre-requisites 

Start Sample Server  

Operational Decision Management provides a sample server to run Decision Center. Before signing in to 
Decision Center, you must start the sample server. 

In this tutorial, you start from a blank project and create the event assets to run an example event 
processing application. By doing so, you discover all the steps required to develop, deploy, and maintain 
a rule-based application. 

To start the Sample Server: 

1. Click Start > All Programs > IBM WebSphere Operational Decision Management V7.5 > 
Start Samples Server. 
 

2. Wait until you see the message BUILD SUCCESSFUL in the console. 

 

Note: The server might take a few minutes to start. 

3. Enter the following URL in a browser: 

http://localhost:9081/wbe  
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4. The Events runtime login screen should appear. Enter the following authentication and click the 
Login button. 

Username:  admin 

Password: admin 

Tool: Administration 

 

5. Click the Console button at the top left to validate that the server is running. 
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Lab 1 Events Business Track 

In this lab, you will act as a business user, using Decision Center to write, modify, deploy and test event 
rules. 

You will first use Decision Center to become familiar with how event assets are managed and 
maintained. Next you will create new event rules and deploy them to the event runtime. Finally, you will 
test and validate the event rules using the capabilities in Business Space. 

Pre-requisite: Start the sample server, as described in Start Sample Server, if you have closed it or 
stopped it.  

1.1 Introduction to Decision Center Console 

Business users create and edit event rules in Decision Center. Their work is saved in the central 
repository, which manages versioning, history, and multi-user access. 

 This task should take you about 60 minutes to complete. 

 Step 1: Log into Decision Center Console 
 Step 2: Explore: Layout of event assets 
 Step 3: Compose: Creation of new Event Rules and Filters 
 Step 4: Query: Finding and managing event assets 
 Step 5: Analyze: Review and validate the event assets 
 Step 6: Project: Manage versioning and deployment 

1.1.1 Log into Decision Center Console 

Decision Center Console is the browser-based tool used for creating and managing both event and 
business rule assets. The robust capabilities offered through this interface are one of the features that 
distinguishes Operational Decision Management from other decision-based platforms. 

In this exercise we will describe each component of the Decision Center environment. Later in the lab we 
will go into more depth of how to use some of these capabilities. 

To log into Decision Center Console: 

__1.  Navigate to the Decision Center Console URL: 

http://localhost:9081/teamserver 

__2.  Sign in to Decision Center using the following details: 

Username: rtsUser1 

Password: rtsUser1 

Note: Decision Center can handle different user profiles. Here you sign in as a regular business 
user.  
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__3.  On the Decision Center Home tab, in the Project in use field, select Banking Events. 

 

 

Note: 

Depending on the environment you are using, your project 
list may look different than this screen shot. As long as it 
contains the Banking Events project then you should be all 
set. 

1.1.2 Explore: Layout of event assets 

The Explore tab in Decision Center allows you to view and organize the event assets. 

__1.  Click the Explore tab to open the event project navigation. 

 

__2.  Note the Smart Folders view on the left-hand part of the screen. This area represents all of the 
assets contained within this event project. 

 

__3.  We will now view each of the asset types. 

__a.  Click the Business Objects node in the Smart Folders view. This will display all of the 
Business Objects within this event project. 
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__b.  In the main navigation window, you can also click on each of the Business Objects to get 
more details about the specific fields, documentation, change history and other important 
information. 

   

__c.  Click the Explore link or the Explore tab to return to the Smart Folders view. 

   

__d.  Click the Actions node in the Smart Folders view. This will display all of the Actions 
within this event project. 

   

__e.  You can now click on the individual Action to gain more information about the author, 
verbalization, change history, fields, and more. 

   

__f.  Click the Explore link or the Explore tab to return to the Smart Folders view. 

   

__g.  Click the Events node in the Smart Folders view. This will display all of the Events for 
this event project. 
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__h.  Similar to the Action details, you can view the Event details by clicking on the individual 
Event in the list. 

   

 

Note: 

So far all of the assets we have viewed are read-only. If the 
Business Objects, Events or Actions need to be modified, 
this needs to be done through Event Designer, the Eclipse-
based developer environment. These assets are for 
reference-only in the Decision Center environment. 

__i.  Click the Explore link or the Explore tab to return to the Smart Folders view. 

   

__j.  Click the Named Constants node in the Smart Folders view. This will display all of the 
Named Constants for this event. 

Named Constants are variables and parameters you can set in the project so that 
thresholds or values do not need to be entered directly into the Event Rules and Filters. 
These are especially useful when many Events Rules or Filters share a common value 
that may need to be modified over time. 

   

__k.  Notice that there are not yet any Named Constants for this project. New Constants can 
be created directly from this view as needed. 

   

__l.  Click the Explore link or the Explore tab to return to the Smart Folders view. 
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__m.  Click the Filters node in the Smart Folders view. This will display all of the Event Rules 
for this event project. 

   

__n.  From the main view you can author new Filters, edit existing, lock, delete and basically 
manage all Filters in this project. By clicking on an individual Filter we can get information 
about the content, author, documentation, history and other important details. 

   

__o.  Click the Explore link or the Explore tab to return to the Smart Folders view. 

   

__p.  Click the Rules node in the Smart Folders view. This will display all of the Event Rules 
for this event project. 

   

__q.  From the main view you can author new Event Rules, edit existing, lock, delete and 
basically manage all Event Rules in this project. By clicking on an individual Event Rule 
we can get very robust information about the content, author, documentation, history and 
other important details. 
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1.1.3 Compose: Creation of new Event Rules and Filters 

In addition to creating Event Rules and Filters from the individual asset management views in the 
Explore area, we can also directly create new assets using the composing area. 

__1.  Navigate to the composing area by clicking the Compose tab 

. 

__2.  Notice that along the left there are options to choose the type of asset we wish to create. When 
the desired asset has been selected, click the OK button in the main navigation area. 

 

__3.  Explore the different assets but do not actually create anything yet – this will be covered in more 
detail later in the lab. 

1.1.4 Query: Finding and managing event assets 

As event projects become larger it is important to easily locate existing assets based on a wide-variety of 
qualifications. For example, if you are asked to create a new Event Rule that responds to a given Event, 
you may want to find all assets that use that Event in some way. Similarly, if you want to know if there is 
already a similar Event Rule or Filter in place you may want to reuse it.  

Queries give the capability to quickly find any asset in the event project as well as to optionally take a 
specific action (such as mark “Deployable”) on those assets that are found. 

__1.  Navigate to the query area by clicking the Query tab. 

 

__2.  Click the Query tab, and click New. 
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__3.  Explore the different options in the query text area by clicking it, moving the cursor to the end of 
the line, and typing Ctrl+Space to bring up the editor menu. We will explore this area in more 
detail later in the lab. 

1.1.5 Analyze: Review and validate the event assets  

After you’ve run a query you will have a list of artifacts matching the query.  For example, if you searched 
for all event rules that trigger a certain action you would see that set of rules and could proceed to make 
whatever changes were necessary to those rules.  We will explore this in more detail later in the lab. 

In addition to running a query, you can use the results of a query to generate a report. 

To generate a report: 

__1.  Navigate to the analyze area by clicking the Analyze tab. 

 

__2.  Notice that there are a few  

 

__3.  You now have the option to choose a Query to use to generate the report (for example, only give 
a report of all Events in the project or give a report of all “deployable” assets). In this project 
there should not be any saved Queries so just click the Generate Report button. 
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__4.  The following progress screen will appear for a few moments. 

 

__5.  When the project report has been generated, click on the Banking Events link to view the 
report. 

 

__6.  Review the report and close it when finished. 

1.1.6 Project: Manage versioning and deployment 

Sometimes multiple people may need to work with the same event rules artifacts.  In that case you have 
the ability to create “branches” of a project; a branch is simply a way to isolate your changes from the 
changes that others are making.    

To manage Subbranches and Baselines: 

__1.  Navigate to the project management view by clicking the Project tab. 

 

__2.  Notice there are different options for both management and deployment of the project. We will 
cover these capabilities in more detail later in the lab but for now click the Manage 
Subbranches and Baselines link. 
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__3.  While there should not currently be any subbranches or baselines in this project, this should give 
a good understanding of where these assets can be managed. 

 

You have now successfully completed the first lab in this series. 

 

1.2 Create a new Filter and Event Rule 

Filters and Event Rules are the central assets a user can create, modify and manage in Decision Center. 
In this lab you will learn how to create these assets and deploy them to the Events runtime. 

 This task should take you about 30 to 40 minutes to complete. 

 Step 1: Log into Decision Center Console 
 Step 2: Remove any existing Event Rules 
 Step 2: Create a new Filter 
 Step 3: Create a new Event Rule 
 Step 4: Deploy the modified project 

1.2.1 Log into Decision Center Console 

To log into Decision Center Console: 

 

Note: 

If you are still logged in to Decision Center from the 
previous lab you can skip to step 1.2.3.  

__1.  Navigate to the Decision Center Console URL: 

http://localhost:9081/teamserver 

__2.  Sign in to Decision Center using the following details: 

Username: rtsUser1 

Password: rtsUser1 

Note: Decision Center can handle different user profiles. Here you sign in as a regular business 
user.  

__3.  On the Decision Center Home tab, in the Project in use field, select Banking Events. 
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1.2.2 Remove any existing Event Rules 

In the current project there may be Event Rules that were already created. For our testing purposes, we 
will delete these existing Event Rules so that our new Event Rule is easier to find. Don’t worry – this 
project is backed up and part of the lab materials in case a mistake is made. 

To delete the Event Rules: 

__1.  Navigate to the composing area by clicking the Explore tab. 

 

__2.  In the Smart Folders view, click the Rules link. 

  

__3.  Select all of the Event Rules (either by checking the box next to each one individually or clicking 
the checkbox in the column header to check all of them). Then click the Delete button. 

  

__4.  Click the Yes button to confirm the deletion of these Event Rules. 

 

__5.  You should now see an empty list with no Event Rules. 
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1.2.3 Create a new Filter 

Filters are reusable pieces of logic that can be leveraged in one or more Event Rules. By externalizing 
the logic we are able to more easily manage the event processing capabilities and grow the application 
over time. 

To create a Filter: 

__1.  Navigate to the composing area by clicking the Compose tab. 

 

__2.  Select the type Filter on the left and click the OK button. 

 

__3.  Enter “Large Transaction” as the name of the new Filter and click the Next button. 

 

__4.  Notice that the verbalization of this new Filter has been generated for you automatically. You can 
optionally modify this so that it reads better or is more intuitive when adding the Filter to an Event 
Rule. In this example, leave the default text “large transaction” as is. 

 

__5.  Below the verbalization is a text box used for writing the Filter. Click the <condition> link to view 
all of the possible options to use in the Filter text. You may also optionally directly type into this 
box as well. 
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__6.  Select the item the amount of <a transaction details>. 

 

__7.  Notice that as you make selections, additional menus will appear guiding you through the 
creation of the Filter. These menus are contextual and will be dependent of the event project and 
where you are in the Filter statement. Select the option the transaction details. 

 

__8.  When the next menu appears, select is at least <a number>. 
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__9.  Select <number>. 

 

__10.  By typing into the box, replace the default “0” with “1000”. 

 

__11.  Click the Next button. 

 

__12.  Click the Next button again to skip adding tags. 

 

__13.  In the Documentation text box, add a description about what the Filter is meant to do or other 
important details (does not need to match exactly with the text below). 
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__14.  In the Version Information text box, add some comments about this particular version of the Filter 
(does not need to match exactly with the text below) and click the Finish button. 

 

__15.  You should now see a summary screen confirming the creation of the new Filter. 

1.2.4 Create a new Event Rule 

In Event projects, Event Rules are the assets that bring all of the other assets together. They combine an 
Event, conditions (often in the form of Filters) and one or more Actions. We also specify a “context 
relationship” (the correlation identifier) which is how Events, Actions and Business Objects may be 
related over long periods of time and between multiple Events. 

To create an Event Rule: 

__1.  Navigate to the composing area by clicking the Compose tab. 
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__2.  Select the type Event Rule on the left and click the OK button. 

 

__3.  Enter “Send Alert on Large Transaction” as the name of the new Event Rule and click the Next 
button. 

 

__4.  An Event Rule is always in response to an Event. In addition, we need to identify the “context” 
that will be used to process the Event Rule (this is how the engine will determine how events are 
related to one another). For this new Event Rule, select the Event cardTransaction and the 
Context the account number of the transaction details. 

 

__5.  In the text box, click the <conditions> link to open the editor menu. Select the Filter large 
transaction for the condition. Notice that the icon is different (a funnel with a down-arrow 
indicating a Filter element) and the documentation is what we entered for the previous section of 
the lab. 
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__6.  Click the <action> link and choose the item send alert with <Alert Type>. 

 

__7.  In the next menu that appears, select the item <string> in order for us to enter text for the type 
of alert being generated. 

 

__8.  Enter the text “Large Transaction” between the quotes to specify the type of alert. 

 

__9.  Click the Next button at the bottom of the editor. 

 

__10.  Click the Next button to skip adding a tag. 
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__11.  Enter some documentation text about the new asset (the text does not need to match what is 
below) and click the Next button. 

 

__12.  In the next screen add some comments about this version (does not need to match what is 
below) and click the Finish button. 

 

__13.  You should now see a screen confirming the creation of the Event Rule. 

 

1.2.5 Deploy the modified project 

As you make changes in Decision Center, you should continually deploy and test the changes. Because 
a new project deployment does not require any compiling or restarting of the server, it is very easy to 
incrementally deploy and test projects as they are developed. 

To deploy the project: 
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__1.  Navigate to the project area by clicking the Project tab and click the Deploy Project link.  

 

__2.  You are now presented with some deployment options. You can choose a Query to apply to the 
deployment as well as select what event runtime to deploy to. Further, you have the option to 
create a baseline of the runtime version of the project. For this lab, un-check the Create a 
baseline checkbox and click the OK button. 

 

__3.  You should now see a progress screen like the following: 
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__4.  A few moments later you should see a confirmation screen indicating the deployment was 
successful. 

 

 

You have now successfully completed the second lab in this series. Log out of Decision Center and close 
the browser. We will now test our new event project. 

 

1.3 Exploring Business Space 

Business Space is a Web 2.0 mash up environment that allows for various capabilities for end users.  

 This task should take you about 50 to 60 minutes to complete. 

 Step 1: Log into Business Space 
 Step 2: Event simulation and testing 
 Step 3: Event capture and replay 
 Step 4: Visibility with Dashboards  

1.3.1 Log into Business Space 
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Note: 

If you are logged into Decision Center from the previous 
lab, log out of Decision Center and close the browser 
before proceeding.  

Once the project has been deployed (either through Event Designer or Decision Center) we can easily 
test the project using the Event Testing Widget in Business Space. 

To log into Business Space: 

__1.  Open Firefox and navigate to the URL: 

http://localhost:9081/mum/resources/bootstrap/login.jsp 

__2.  Log into Business Space by entering the username and password of “admin” and clicking the 
Login button. 

 

__3.  If the Welcome Screen (below) appears, we need to add the WODM Events space to the 
environment. If the WODM Events space appears, skip this step. 

 

__a.  Click the Manage Spaces link. 
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__b.  Click the title of the space WebSphere Operational Decision Management. 

 

__4.  You should now see a page that has a title like the following: 

 

1.3.2 Event simulation and testing 

Once the project has been deployed (either through Event Designer or Decision Center) we can easily 
test the project using the Event Testing Widget in Business Space. 

__1.  Click on the Event Testing tab in Business Space to open the Testing widget. 

 

__2.  Click the Restart Testing button in order to clear any existing history data. 

 

__3.  Now click the Select Event Template in order to choose the Event we will generate manually 
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__4.  Select the Event cardTransaction and click the OK button. 

 

__5.  Click the triangle twisty next to the transaction title and enter the values accordingly. Note – 
these can be any values you want but be sure to enter an amount greater than “1000” in order 
for the rule to fulfill the condition created in the previous section and generate the action. When 
the values are entered, click the Send Event button. 

 

__6.  The following text (or something similar) should appear at the bottom of the widget: 
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__7.  Now click on the Filters tab within the Event Tester widget. Two entries should have been 
created for the evaluation of this event instance, each with a result of “True”. One entry is for the 
Filter evaluation and the other is for the overall evaluation of the Event Rule (since an Event Rule 
may have logic built directly into it). 

 

__8.  Now click the Actions tab in the Event Tester widget. An entry should have been created for the 
execution of this action. Click on the entry and click the triangle twisty next to the alert title that 
appears at the bottom of the widget. You should be able to verify that all the values came 
through successfully. 

 

__9.  Now that we have tested the new Event Rule we can now optionally clean up any historical data 
by clicking the Restart Testing button at the top of the Event Tester widget. 

 

1.3.3 Event capture and replay 

Simulating Events one at a time is very useful, but may not fulfill all of the testing and validation needed 
for a project. Business Space also offers the capability to capture or “record” Events as they are 
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happening and then replay them over and over again in a time compression. In other words, you do not 
need to wait an entire day for a full day’s worth of Events to be replayed. 

This also gives the ability to export or import the recorded events into an alternate runtime so that users 
can test events recorded in other environments. This is especially useful for testing the impact and 
validating the Event Rules against real Events that have been captured from the production system 
(even if that production environment does not yet have any Event Rules associated with it yet). 

To capture and replay Events: 

__1.  Click on the Event Capture and Replay tab in Business Space to open the Event Capture and 
Replay widget. 

 

__2.  Click the Start Capture button in the Event Capture widget. 

 

__3.  We will now generate some Events to record. Click on the Event Testing tab in Business Space 
to open the Testing widget. 

 

__4.  Click the Restart Testing button in order to clear any existing history data. 
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__5.  If the cardTransaction Event is not yet selected, click the Select Event Template in order to 
choose the Event we will generate manually 

 

__6.  Select the Event cardTransaction and click the OK button. 

 

__7.  Enter the Event data – but in this case enter an amount that will not trigger the Event Rule 
(make it less than “1000”). When the data is entered, click the Send Event button. 

 

__8.  Repeat the previous step three or four more times and with the last event, make the amount 
field greater than “1000”. 
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__9.  Since these Events were processed, we want to clear out the history before replaying them from 
the Event Capture and Replay widget. Click the Restart Testing button to clear the historical 
data. 

 

__10.  Return to the Event Capture and Replay widget by clicking the Event Capture and Replay tab. 

 

__11.  Click the Stop Capture button in the Event Capture widget to stop the recording. 

 

__12.  Click the Load button in the Event Replay widget and select the new event capture set.  

 

 

Note: 

You may need to select Refresh list and click the Load 
button again for the new list to appear. 
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__13.  Select all of the Events by clicking each checkbox individually or clicking the Select All button at 
the top-right of the widget (1). Then click the Replay Selected button (2) to replay the events. 

 

__14.  Now, go back to the Testing widget by clicking the Testing tab. 

 

__15.  Click on the Filters tab to see all of the evaluations from the replayed Events. The last two 
evaluations should read “True”. 

 

__16.  You can now replay these Events over and over again (even with different Event Rules) to test 
the logic. Simply click the Restart Testing button in the Tester, and then replay the Events from 
the Event Replay widget after deploying a new project. 
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1.3.4 Visibility with Dashboards 

Charts and graphs are a very useful method for exposing some of the runtime information out to end 
users for better visibility and understanding.  

Because a page for the Events Dashboard may not have been created in the current Business Space 
environment, this exercise will also illustrate how a user can customize Business Space.  

__1.  Add a new page to Business Space for the Dashboard. 

__a.  If the Dashboard tab already exists, you should delete it before proceeding to the next 
step. If the Dashboard tab does not exist, continue to the next step (b). 

__i.  Click the down arrow button in the Dashboard tab. 

 

__ii.  Click the Delete option in the menu to delete the tab. 

 

__iii.  In the confirmation window, click the Delete button. 

 

__b.  Click the  button next to the tabs in Business Space to add a new page. 
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__c.  Enter “Dashboard” for the page name and click the OK button. 

 

__d.  Click the Edit Page button. 

 

__e.  Click the “Change Layout” icon in the toolbar on the right and select the T layout. 
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__f.  Now drag the Event Chart Manager widget into the empty space in the top of the page. 

 

__g.  We will now repeat the previous step to drag the Event Chart widget to the two lower 
panes of the “T”. 

 

__h.  Click the Save button and then the Finish Editing button. 
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__2.  In the new Event Chart Manager widget, click the Add Chart button. 

 

__3.  Click the Select chart type drop-down button and select Meter. 

 

__4.  Enter “Recent Transactions” as the name of the new chart and change the values of Range Max, 
Warning, and Critical to “10”, “6”, and “8”, respectively. 

 

__5.  Click the Select variable type drop-down button in the Charted variables tab and select Event. 

 

__6.  Click the Add a variable button. 

 

__7.  In the window that appears, select the cardTransaction Event. 
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__8.  Click the Time range tab and change the refresh rate to “1”. 

 

__9.  Click the Save changes button. 

 

__10.  In the Event Chart Manager widget, click the Add chart button. 

 

__11.  Click the Select chart type button and select Line. 

 

__12.  Enter “Recent Events” as the name of the new chart. 
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__13.  Click the Select variable type drop-down button and choose Event. 

 

__14.  Click the Add a variable button and select the cardTransaction Event. 

 

__15.  Click the Add a variable button again and select addressChange. 

 

__16.  Click the black color box next to each of the variables and choose a different color for the line. 

              

__17.  Click the Time range tab and change the refresh rate to “1”. 

 

__18.  Click the Save changes button. 

 

__19.  Click the Edit Page button at the top-right of the screen. 
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__20.  In the Event Chart widget on the left, click the down-arrow and select Edit Settings… 

 

__21.  In the window that appears, expand the Meter folder, select Recent Transactions and click the 
OK button. 

 

__22.  Repeat the previous two steps for the widget on the right to select the Recent Events line chart. 

__23.  Click the Finish Editing button. 

 

__24.  The page should now look something like this: 

 

__25.  Test the charts 

__a.  Go to the Testing widget by clicking the Event Testing tab. 
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__b.  If the cardTransaction Event is not yet selected, click the Select Event Template in 
order to choose the Event we will generate manually and select cardTransaction. 

   

__c.  Enter the Event data – the values do not make a difference for this test. 

__d.  Repeat the previous step three or four more times so that there will be a few Events 
visible in the charts. 

__e.  Return to the charts by clicking the Dashboard tab. 

 

__f.  The charts should appear to looks something like this: 

 

__26.  Log out of Business Space. 

 

 

You have now successfully completed the third lab in this series. 

 

1.4 Asset Governance in Decision Center 

Decision Center has very powerful capabilities in the area of governance. In this lab we will explore the 
design-time “Branch and Merge” feature as well as semantic queries. 
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 This task should take you about 30 minutes to complete. 

 Step 1: Log into Decision Center Console 
 Step 2: Create a Subbranch 
 Step 3: Modify an Event Rule 
 Step 4: Merge braches 
 Step 5: Create and run a new Query 

1.4.1 Log into Decision Center Console 

To log into Decision Center Console: 

 

Note: 

If you are logged into Business Space from the previous 
lab, log out of Business Space and close the browser 
before proceeding.  

__1.  Navigate to the Decision Center Console URL: 

http://localhost:9081/teamserver 

__2.  Sign in to Decision Center using the following details: 

Username: rtsUser1 

Password: rtsUser1 

Note: Decision Center can handle different user profiles. Here you sign in as a regular business 
user.  

__3.  On the Decision Center Home tab, in the Project in use field, select Banking Events. Note that 
the Branch in use should default to “main”. 

 

1.4.2 Create a Subbranch 

Subbranches are very important for design-time versioning in Decision Center. Users may work on 
various versions or copies of projects simultaneously and then later visually merge changes back 
together as needed. 

To create a subbranch: 
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__1.  Under the Current action field within the Home tab, choose Create a subbranch. 

 

__2.  In the next screen enter a name for the new subbranch (does not need to match the one in the 
screenshot below) and click OK. 

 

__3.  Make sure the Banking Events project is still selected, that the new branch is selected in the 
Branch in use field, and the Current action is Work upon branch. Now click the Explore tab. 

 

1.4.3 Modify an existing Event Rule 

We will now change the rule that we created earlier. Since we are in a new branch, the changes will not 
impact anything in the previous “main” branch until we decide to merge the changes together. 

To modify an existing Event Rule: 

__1.  Make sure that Rules item is selected in the Smart Folders view and click on the Event Rule you 
created in the previous lab. 
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__2.  Click the Edit button in the Event Rule toolbar.  

 

 

Note: 

Alternatively to these two steps, you could also check the 
box next to the Event Rule and click the Edit button on the 
first screen.  

__3.  On the screen that appears, click the Next button to proceed with editing the Event Rule. 

 

__4.  Modify the Event Rule in some way. In the example below, a new condition has been added to 
make sure that an alert has not already been sent for this account number. 

 

__5.  Click the Finish button to save the Event Rule. 

1.4.4 Merge branches 

We will now merge the changes into the rule that we created earlier. 

To merge branches: 
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__1.  Click the Project tab and click the link Merge Branches. 

 

__2.  Note that at the top right of the Decision Center screen it shows you what branch you are 
currently working on. This screen gives the option to choose a branch to merge the project into. 
In this project, there is only one other branch (“main”) so make sure that is selected and click 
Next. 

 

__3.  After a few moments you will then see a screen showing all of the differences between the 
branches. This also gives you the option to apply a single action to the differences 
(“Bidirectionally”, “Only to ‘main’ branch” or “Only to ‘v1.1’ branch”). However, a key capability in 
Decision Center is the ability to not only check for changes and differences but to visually 
compare these differences and individually choose what to do with them.  

Click on the  button in the table to open the visual compare screen. 

 

__4.  Here you see the Event Rule in its entirety and we can decide what we want to do with the 
differences. For example, we can click the Copy All from Left to Right button to push the newly 
modified rule to the “main” branch as well. 
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1.4.5 Create and run a new Query 

Queries are excellent ways of managing and finding assets in Decision Center. As projects grow, it often 
becomes very complicated to track and understand all of the various assets that exist in the project. In 
this lab you will learn how to create a simple Query and run it. 

__1.  Click the Query tab to open the Query Editor screen. 

 

__2.  Create a query like the following (this will find all events that contain the word “Transaction” in 
the name). Note that the same type of contextual editor menus appear as they do when creating 
Event Rules and Filters. When finished, click the Save button. 

 

__3.  Once the Query is saved, click the Run Query button in the toolbar. 
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__4.  You should two of the Events in the project appear in the results table. 

 

 

You have now successfully completed the fourth lab in this series. 

 

1.5 Expand the Project (Optional) 

Now that we have touched on the various aspects of the end-user environment, it is now possible to use 
what we have learned to create new Event Rules and Filters in Decision Center and test them in 
Business Space. 

 This task should take you about 20 to 30 minutes to complete. 

 Step 1: Log into Decision Center Console 
 Step 2: Create a new Event Rule 
 Step 3: Deploy the modified project 
 Step 4: Log into Business Space 
 Step 5: Test the project in Business Space 

1.5.1 Log into Decision Center Console 

To log into Decision Center Console: 

 

Note: 

If you are still logged in to Decision Center from the 
previous lab you can skip to step 1.5.3.  

__1.  Navigate to the Decision Center Console URL: 

http://localhost:9081/teamserver 

__2.  Sign in to Decision Center using the following details: 

Username: rtsUser1 

Password: rtsUser1 
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Note: Decision Center can handle different user profiles. Here you sign in as a regular business 
user.  

__3.  On the Decision Center Home tab, in the Project in use field, select Banking Events. 

1.5.2 Create a new Event Rule 

We now want to add additional logic to our existing application. This part should be fairly open ended but 
the lab will give some suggestions on possible Event Rules that could be added for this project. 

To create an Event Rule: 

__1.  Navigate to the composing area by clicking the Compose tab. 

 

__2.  Select the type Event Rule on the left and click the OK button. 

 

__3.  Enter a name for the new Event Rule and click the Next button. 

__4.  We will now set the Event, the Context and the content of the Event Rule. Below are some 
possible suggestions for some new Event Rules (although feel free to create one or more on 
your own): 

 Start Investigation after many address changes. 

 

 Send alert if more than 2 weeks with no card transaction (use 1 minute for testing 
purposes). 
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 Send alert if the sum of transaction amounts are greater than 10,000. 

 

__5.  Click the Finish button. 

__6.  You should now see a screen confirming the creation of the Event Rule. 

1.5.3 Deploy the modified project 

As you make changes in Decision Center, you should continually deploy and test the changes. Because 
a new project deployment does not require any compiling or restarting of the server, it is very easy to 
incrementally deploy and test projects as they are developed. 

To deploy the project: 

__1.  Navigate to the project area by clicking the Project tab and click the Deploy Project link.  

 



IBM Software 

Lab 1 -  Events Business Track Page 55 

__2.  You are now presented with some deployment options. You can choose a Query to apply to the 
deployment as well as select what event runtime to deploy to. Further, you have the option to 
create a baseline of the runtime version of the project. For this lab, un-check the Create a 
baseline checkbox and click the OK button. 

 

__3.  You should now see a progress screen like the following: 

 

__4.  A few moments later you should see a confirmation screen indicating the deployment was 
successful. 

__5.  Log out of Decision Center and close the browser. 

1.5.4 Log into Business Space 

 

 

Note: 

If you are logged into Decision Center from the previous 
lab, log out of Decision Center and close the browser 
before proceeding.  

Once the project has been deployed (either through Event Designer or Decision Center) we can easily 
test the project using the Event Testing Widget in Business Space. 

To log into Business Space: 

__1.  Open Firefox and navigate to the URL: 

http://localhost:9081/mum/resources/bootstrap/login.jsp 

__2.  Log into Business Space by entering the username and password of “admin” and clicking the 
Login button. 
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__3.  You should now see a page that has a title like the following: 

 

1.5.5 Test the project in Business Space 

Once the project has been deployed (either through Event Designer or Decision Center) we can easily 
test the project using the Event Testing Widget in Business Space. 

__1.  Click on the Event Testing tab in Business Space to open the Testing widget. 

 

__2.  Click the Restart Testing button in order to clear any existing history data. 

 

__3.  Now click the Select Event Template in order to choose the Event we will generate manually 

 

__4.  Select the Event that will trigger your new Event Rule(s) and click the OK button. 

__5.  Click the triangle twisty next to the Action Object title and enter the values accordingly. When the 
values are entered, click the Send Event button. 

__6.  The following text (or something similar) should appear at the bottom of the widget: 

 

__7.  Now click on the Filters tab within the Event Tester widget. You should see your new Event 
Rule(s) evaluated and the outcome. 
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__8.  If any of the Event Rules were “True”, click the Actions tab in the Event Tester widget. An entry 
should have been created for the execution of this action. Click on the entry and click the triangle 
twisty at the bottom to verify that all the values came through successfully. 

__9.  Now that we have tested the new Event Rule we can now optionally clean up any historical data 
by clicking the Restart Testing button at the top of the Event Tester widget. 

 

__10.  Log out of Business Space and close the browser. 

 

You have now successfully completed the fifth lab in this series. 

 

Summary 

In this lab you used Decision Center to perform the following business analyst tasks: 

 Introduction to Decision Center 

 Created a new Filter and Event Rule 

 Deployed a project to the runtime 

 Explored Business Space capabilities 

o Event Simulation and Testing 

o Event Capture and Replay 

o Dashboards and Charts 

 Introduced to governance capabilities in Decision Center 

 Expanded the Event Project 
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Appendix A. Notices 

This information was developed for products and services offered in the U.S.A.  

IBM may not offer the products, services, or features discussed in this document in other countries. 
Consult your local IBM representative for information on the products and services currently available in 
your area. Any reference to an IBM product, program, or service is not intended to state or imply that 
only that IBM product, program, or service may be used. Any functionally equivalent product, program, or 
service that does not infringe any IBM intellectual property right may be used instead. However, it is the 
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.  

IBM may have patents or pending patent applications covering subject matter described in this 
document. The furnishing of this document does not grant you any license to these patents. You can 
send license inquiries, in writing, to:  

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A.  

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property 
Department in your country or send inquiries, in writing, to:  

IBM World Trade Asia Corporation 
Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106-0032, Japan  

The following paragraph does not apply to the United Kingdom or any other country where such 
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES 
CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some 
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this 
statement may not apply to you.  

This information could include technical inaccuracies or typographical errors. Changes are periodically 
made to the information herein; these changes will be incorporated in new editions of the publication. 
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice.  

Any references in this information to non-IBM Web sites are provided for convenience only and do not in 
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part 
of the materials for this IBM product and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes appropriate without 
incurring any obligation to you. 

Any performance data contained herein was determined in a controlled environment. Therefore, the 
results obtained in other operating environments may vary significantly. Some measurements may have 
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been made on development-level systems and there is no guarantee that these measurements will be 
the same on generally available systems. Furthermore, some measurements may have been estimated 
through extrapolation. Actual results may vary. Users of this document should verify the applicable data 
for their specific environment.  

Information concerning non-IBM products was obtained from the suppliers of those products, their 
published announcements or other publicly available sources. IBM has not tested those products and 
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM 
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of 
those products. 

All statements regarding IBM's future direction and intent are subject to change or withdrawal without 
notice, and represent goals and objectives only. 

This information contains examples of data and reports used in daily business operations. To illustrate 
them as completely as possible, the examples include the names of individuals, companies, brands, and 
products. All of these names are fictitious and any similarity to the names and addresses used by an 
actual business enterprise is entirely coincidental. All references to fictitious companies or individuals are 
used for illustration purposes only. 

COPYRIGHT LICENSE:  

This information contains sample application programs in source language, which illustrate programming 
techniques on various operating platforms. You may copy, modify, and distribute these sample programs 
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing 
application programs conforming to the application programming interface for the operating platform for 
which the sample programs are written. These examples have not been thoroughly tested under all 
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these 
programs. 
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Appendix B. Trademarks and copyrights 

The following terms are trademarks of International Business Machines Corporation in the United States, 
other countries, or both: 

IBM  AIX CICS ClearCase ClearQuest Cloudscape  

Cube Views DB2 developerWorks DRDA IMS IMS/ESA  

Informix Lotus Lotus Workflow MQSeries OmniFind ILOG  

Rational Redbooks Red Brick RequisitePro System i   

System z Tivoli WebSphere Workplace System p   

Adobe, Acrobat, Portable Document Format (PDF), and PostScript are either registered trademarks or 
trademarks of Adobe Systems Incorporated in the United States, other countries, or both. 

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the United States, other 
countries, or both and is used under license therefrom. 

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems, Inc. in the United 
States, other countries, or both. See Java Guidelines  

Microsoft, Windows, Windows NT, and the Windows logo are registered trademarks of Microsoft 
Corporation in the United States, other countries, or both.  

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon, Intel 
SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its 
subsidiaries in the United States and other countries. 

UNIX is a registered trademark of The Open Group in the United States and other countries.  

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both. 

ITIL is a registered trademark and a registered community trademark of the Office of Government 
Commerce, and is registered in the U.S. Patent and Trademark Office. 

IT Infrastructure Library is a registered trademark of the Central Computer and Telecommunications 
Agency which is now part of the Office of Government Commerce. 

Other company, product and service names may be trademarks or service marks of others. 
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